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Writing this article I am well 
aware of the fact that many of you 
will hate me for what I am doing. 
I collect nice scarabs all over 
the world and then I cut them 
in pieces. “But why should/how 
could anyone do that?” you might 
ask. Well, I have to admit that this 
is not easy for me as I really love 

beetles, but it’s my job. I am looking 
for beetle-associated nematodes 
and the group of nematodes I am 
working with occurs mostly on 
scarab beetles.

The genus Pristionchus is one 
out of 28 genera in the nematode 
family Diplogastridae. Most of 

The author being sweaty but EXTREMELY HAPPY in a scarab shop 
during a collecting trip to Japan.
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the diplogastrid nematodes are 
known to have an association with 
certain insect taxa. Mickoletzkya 
for example can be found on bark 
beetles, Parasitodiplogaster on 

fig wasps and Cephalobium in 
crickets.

In 1996 my boss established 
Pristionchus pacificus as a 
satellite system for comparison 
with probably the best-studied 
animal on earth: the nematode 
Caenorhabditis elegans, or 
C. elegans as most C. elegans 
researchers call their lab animal. 
For many years C. elegans 
and P. pacificus were used to 
compare molecular mechanisms 
concerning cell fate, cell-cell 
interaction, molecular pathways 
and stuff like that. After some 
time the scientists wanted to move 
from this macroevolutionary 
approach to a microevolutionary 
approach, i.e. compare different 
strains of P. pacificus and/or 
closely-related Pristionchus 
species with each other.

The problem was that no one 
had a clue at that time where to 
look for new strains and species 
of Pristionchus. All strains of P. 
pacificus (six at that time) and 
other species of Pristionchus (five) 
had been found in randomly-
taken soil samples. And it was 
fairly unpredictable how many soil 
samples you had to look at to find 
a Pristionchus.

So to be frank, people did not 
know anything about the ecology 
and biology of Pristionchus. 
That’s when I joined the team. 
As there were some hints that 
there might be an insect (and in 
particular a beetle) association 
my boss contacted and hired me 
to look at potential interaction of 
Pristionchus and beetles.

The European chafer Melolontha melolontha - still 
feeding and having fun.

Cut Melolontha melolontha (not so happy anymore) on 
a Petri dish with nematodes crawling out and around 
(now THEY are having fun...).
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To make a long story short I could 
indeed show that our beloved 
nematodes sit on beetles. And 
thankfully enough they don’t sit 
on dull and boring beetles but 
ON SCARABS!!! I did collect 
(and sacrifice) thousands of 
scarabs from all over the world. 
Probably my karma is completely 
f---ed up*-but I could expand the 
Pristionchus species list from six 
to 23 and the number of nematode 
strains to over a thousand. Our 
most wanted species P. pacificus 
seems to be the only cosmopolitan 
species. We now have more than 
100 strains from all over the world, 
and with molecular tools in hand 
we can do fancy things like trying 
to find out how the species got 
spread all over the planet. We 
cannot only see a biogeographic 
pattern in P. pacificus but in the 
whole genus Pristionchus. There 
is for example an American clade 
of Pristionchus species comprising 
P. aerivorus, P. pseudaerivorus, 
P. americanus, P. marianneae, 
P. pauli (named after the 
Phyllophaga guru Paul Robbins), P. 
sp 3, P. sp. 16 and P. sp. 20. These 
are mainly found on Melolonthini 
(several Phyllophaga species but 
also Polyphylla).

But what do these nematodes do 
with the poor scarabs? They are 
neither parasitic nor phoretic. We 
call their life style necromenic. 
They sit on the beetles in a larval 
stage that is called “Dauer.” This 
larval stage does not feed (has 
closed mouth parts) and has 
an especially thick cuticle that 
prevents desiccation. The Dauer 

Abdomen of Melolontha melolontha and thousands of 
crawling nematodes.

A cup of Amphimallon solstitiale still alive and intact – 
waiting to help science.

larvae do not harm the beetles 
but simply wait for them to die. 
After the beetle’s death (which I 
antedate by cutting it in half ) the 
nematodes leave the Dauer stage, 
grow adult and start multiplying 
RAPIDLY. One single female can 
lay up to 300 eggs and it only 
takes 72 hours from egg to egg 
laying female. So after few days 
the whole beetle will be covered 

*Editors’ Note: We 
suspect this is a slang 
German term for “fouled 
up.”
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in worms crawling around just 
like maggots on a bigger carcass. 
They feed on bacteria and fungi 
degrading the dead beetle.

We do find certain Pristionchus 
species in close association 
to certain beetle species. This 
led us to the question how the 
nematodes can find their hosts. 
We found out that these 1 mm 
small worms can indeed sense and 
use the beetles pheromones. In P. 
maupasi, e.g., which is associated 
with the European cockchafer 
Melolontha melolontha, the 
nematodes are attracted to traces 
of phenol - a known compound 
in the beetles’ chemical 
communication. So given the fact 
that the association sometimes 
is very close (not necessarily 
species specific but at least genus 
specific), and the multitude of 
scarab genera, there should 
be many more undiscovered 
Pristionchus species out there on 
scarabs.

I would greatly appreciate if some 
of you could send me scarabs to 
check them for new Pristionchus 
species or strains. The beetles 
should be alive or at least freshly 
dead and not killed by freezing 
or any chemical because this 
would harm the nematodes as 
well. Please don’t hesitate to 
contact me if you have any other 
questions.

Cutting these Lucanus cervus hurt me a lot!!!

Exomala orientalis - the Oriental beetle - bears our 
beloved P. pacificus, both in Japan and the U.S.

Amphimallon male (confused) and Anoxia  female 
(surprised) can carry nematodes.
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Photography of Pinned Chrysina
Part II - Processing the Image
by the Editors

What follows can be applied to 
any scarab, or any beetle, for that 
matter. We apologize, as this is 
supposed to be a newsletter about 
scarab beetles. Even though this 
subject is definitely tangential 
to scarabs sensu stricto, we felt 
it important enough to sacrifice 
these pages to help those who may 
be struggling with the behemoth 
we call Photoshop.

Using Camera Raw

Once you have your image files 
transferred to your computer, 
you will want to process them in 
Camera Raw. On our Macs (sorry 
PC, our staff refuses to work on 
Windows computers - see Photo 
1), we select the images and drag 
them onto Photoshop’s icon in 
the Dock. As mentioned at the 
end of Part I, we hope you shoot 
your photographs in the Raw 
format because they contain the 
most information. Even if you 
do not have Raw files, you can 
(and should) open them into the 
Camera Raw Converter - a most 
powerful tool. To open a non-Raw 
image, simply boot Photoshop, 
select File -> Open... then select 
the file(s) and go to the little box in 
the lower left corner (Photo 2) and 
select Camera Raw.

If you have several images open 
that were shot under identical 
lighting conditions, you can open 
them in Camera Raw, hit the Select 

All button in the upper left corner 
of the Raw Converter and process 
all these images together.

Referring to Photo 3, let’s go 
through the sliders and make some 
adjustments. Most pinned scarabs 
are going to be photographed 
against a white foam pinning 
surface. The advantage to this white 
background is not much ink is 
required if the image is printed on 
white paper. The other common 
background is black velvet. Note 
that it readily shows dust particles. 
Remove them by dabbing the velvet 
with the sticky side of adhesive 
tape. When making adjustments 
in the Raw Converter, disregard 
the background and keep your 
attention on the specimen. If the 
background is splotchy, we can 

Photo 1: Proofreader 
Sonja (see page 20 of 
this issue) is never far 
from her beloved iMac.

Photo 2: Opening a JPG (JPEG) file in 
Camera Raw.
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easily transform it to pure black or 
pure white in Photoshop. This will 
be covered later in this article. 

If your camera’s white balance was 
set to flash (and you used flash as 
discussed in Part I), there should 
be no need to fiddle with Color 
Balance or Tint. If this did not 
happen, you can choose the light 
that was used to light the specimen 
from the White Balance pull-down 
menu.

While using the next group 
of sliders, keep an eye on the 
histogram. If you used a black 
background, you will see a big 
spike on the left side of the 
histogram. This is simply the black 
background. If the spike is all the 

way to the left, that means there 
are areas of black that are so dark 
they hold no detail. That’s O.K. 
because we don’t want detail in the 
background. Conversely, a spike on 
the far right means there are areas 
with loss of detail (pure white) in 
the image. This is usually the white 
background, so this is permissible 
and desirable.

What we don’t want are “blown 
highlights” (as they are called 
by photographers) to be on the 
specimen. To check for this, 
turn on the highlight warning 
by clicking on the small triangle 
in the upper right part of the 
histogram. Blown highlights (white 
with no detail) will now show as 
bright red. There should be no 

Photo 3: Adobe 
Camera Raw. This 
is a most powerful 
starting point for your 
photographs. Make it 
your friend!
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blown highlights on the specimen 
itself, but it is desirable to have 
the white background blown. 
Remember, make your adjustments 
on the specimen and ignore the 
background.

Conversely, if you click on the little 
triangle on the upper left part of 
the histogram, you will turn on 
the shadow warning. Blocked-
up shadows (black areas with no 
detail) will be shown as bright blue 
areas. Again, we don’t want these 
on the specimen.

First, adjust the Exposure slider 
back and forth to fine tune the 
exposure on the specimen. Again, 
ignore what happens to the 
background. If you lighten the 
image and blown highlights (shown 
as red on the beetle) appear, slide 
the Recovery slider to the right 
until the blown highlights (red) 
disappear. Play with the Fill Light 
slider to see if it improves the 
image. Adjust the Black slider in 
the same fashion. If you go too high 
with it, you will get blocked-up 
shadows (blue) on the specimen. 
Adjust the Brightness slider up 
or down until you are happy. Do 
not touch the Contrast slider; 
a Curves Adjustment Layer in 
Photoshop does a better job. The 
Clarity and Vibrance sliders affect 
the image in a way that is difficult 
to observe unless the image is at 
100% magnification. We usually 
set them both at 20. Do not touch 
the Saturation slider; it saturates 
areas that are already saturated 
with color. The Vibrance slider, on 
the other hand, saturates areas that 
are under saturated. This is highly 

desirable.

The Chrysina in Photo 4 has 
several problems. There is a 
terrible orange color cast, as this 
scarab was photographed using 
tungsten light, and the white 
balance setting in the camera was 
set to flash. Setting Camera Raw’s 
White Balance to Tungsten (Photo 
5) solved the problem.

The next problem is that the 

Photo 4: This Chrysina image has several problems: an 
orange color cast, the beetle is underexposed, and it is 
neither perfectly horizontal nor vertical.

Photo 5: A simple change of the White Balance setting 
to Tungsten removes the awful color cast.
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beetle is underexposed. Setting 
the Exposure slider to +1.40 
(Photo 6) really helped. Notice 
on the histogram there are blown 
highlights that even the Recovery 
slider could not fix. These are the 
small specular highlights on the 
right elytron. Click on Open Image 
to bring the image into Photoshop.

Straightening the Specimen

If you have a horizontally-oriented 
specimen, you may as well make 
it vertical now (Photo 7) by going 

to Image -> Rotate Canvas and 
choosing either 90˚ CW or 90˚ 
CCW.

The first task once inside of 
Photoshop is to make sure the 
specimen is perfectly vertical 
or horizontal. This is easily 
accomplished. First, let’s make a 
duplicate layer of our photo and 
work on that. Press Command-J (PC: 
Control-J). Select the Ruler Tool, 
which is found with the Eyedropper 
tool. Position this tool (the center of 
the “+” sign) over the elytral suture 
at the scutellum. Click and keep 
holding the mouse button down. 
Now position the tool about 1/3 to 
1/2 of the down the elytral suture 
and release the mouse button. 
Photoshop will draw a line over this 
part of the elytral suture.

Next go to Image -> Rotate Canvas 
-> Arbitrary, as shown in Photo 8. 
You will see a box named Angle: 
with a number in it. Click OK. Your 
specimen will now be perfectly 
vertical (or horizontal, if you shot 
the specimen horizontally).

Now crop your image to your liking 
with the Crop tool.

If you need to change the image 
size or/and its resolution, now is a 
good time to do it. Under the Image 
menu, choose Image Size...

Fixing Splotchy White or Black 
Backgrounds

The first step to fixing the 
background to add a new layer: 
Layer -> New -> Layer... In the 
dialog box that appears, give it 

Photo 6: A simple push of the Exposure slider helped 
out not only the Chrysina, but the background as well.

Photo 7: Rotating the canvas to a vertical orientation.
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a name if you would like, set 
Mode: to Overlay, check Fill with 
Overlay-neutral color (50% gray), 
as in Photo 9. The 50% gray is 
transparent in the Overlay layer 
blending mode, which is why your 
photo looks the same. We will be 
making our adjustments on this 
layer.

If you have a splotchy black 
background, you will want to make 
it pure black. Select the Burn tool. 
In the Options Bar, under Range: 
select Shadows and for Exposure: 
select somewhere between 10% 
and 30%, as in Photo 10. Now click 
and drag over the light spots on 
the background. If your scarab 
is mid-toned, it should not be 
affected if you accidentally paint 
over it, because you have your 
Burn Tool set to only affect the 
shadow areas.

For lightening white backgrounds, 
use the Dodge tool. Set the Range: 
to Highlights and Exposure to 
10-30%, as in Photo 11. Paint 
over the darker spots of the white 
background until they are pure 
white. Again, your specimen 
should not be affected if you paint 
over it.

Removing Unwanted Spots

Dust spots on the images can 
easily be removed by clicking on 
them with the Spot Healing Brush.

Removing the Pin

Use the Clone Stamp tool for this. 
The key to using this tool is to use 
a soft brush and to change the 

source point often by Option (PC: 
Alt)-clicking on the area you want to 
clone from.

Sharpening

Sharpening the image should be the 
final step. For this, the sharpening 
sequence should be recorded as 
an action. This way, any time you 
want to sharpen a photo, you only 
need to click once. What we will 
do next is to record three actions. 

Photo 8: Straightening the specimen so it is perfectly 
vertical.

Photo 9: Creating a new blank layer to make our Burn or 
Dodge adjustments on.

Photo 10: Options Bar settings for the Burn Tool to make 
a black background totally black.

Photo 11: Options Bar settings for the Dodge Toot to 
make a white background totally white.
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Each action will render in turn a 
minimal, medium and high amount 
of sharpening without altering the 
colors of the specimen.

1. Open any photo to use as a test. 
Make your Actions panel visible 
(Window -> Actions).

2. Let’s make a folder to store our 
actions in. Click on the Folder 
icon (fourth icon from left) at the 
bottom of the Actions panel. Name 
it Sharpening and press OK.

3. Now click on the Create New 
Action Icon (fifth icon from the 
left), name the action Sharpen 
Medium and click OK.

4. To start recording the action 
click on the Begin Recording Icon 
(second from left).

5. Go to the Filter menu, under 
Sharpen choose Unsharp Mask.

6. Set the Amount to 85%, Radius 
to 1.0, and Threshold to 4. Click 
OK.

7. Immediately after clicking OK, 
go to the Edit menu and choose 
Fade Unsharp Mask. In the 
dialog box that appears, choose 
Luminosity in the Mode: pop-up 
menu. Click OK.

8. At the bottom of the Actions 
panel, click on Stop Recording/
Playing button (first icon on the 
left).

Your test image should now be 
sharpened. To see the effect of the 

next two sharpening actions, you 
may want to go to the File menu 
and choose Revert to bring it back 
to its original state.

Repeat steps 3-8, and call the next 
action Sharpen High. For step 6, set 
the Amount to 120%, Radius stays 
at 1.0, and Threshold to 3.

Repeat steps 3-8, and call the next 
action Sharpen Low. For step 6, set 
the Amount to 100%, Radius stays 
at 1.0, and Threshold to 10.

For most images, Sharpen Medium 
will work fine. Some will only need 
Sharpen Low. Sharpen High will 
seldom be used. If you don’t like the 
look the action gives, you can get 
your original back by File -> Revert, 
which will bring back the file to 
what it looked like when it was last 
saved.

Remember too that a properly-
sharpened image often looks bad on 
the screen, but will print beautifully. 
The key is to use as little sharpening 
as possible. Experience will be a 
great aid in choosing which action 
to use.

Once you have your scarab image 
opened, and have chosen which 
sharpening action to use, you 
only need to select the name of 
the action in the Actions panel by 
clicking on it, then click on the Play 
Selection button (third icon from 
left).

Remember to save your image and 
backup your files.

Here is Jennifer with her 
Mac Pro and Wacom 
Cintiq graphics tablet. 
Besides helping Sonja 
with proofreading 
chores, Jenn does the 
initial layout for Scarabs 
and retouches every 
photo.
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Dynastes granti Horn in
Arizona

by the Editors

Here a female is shrouded with shredded bark.

This male is walking to another spot, as the 
branch he is on is wider than the preferred 
diameter used for feeding.

The scars Dynastes creates can be seen at least 
a year later.

Dynastes granti Horn is a common scarab in 
central Arizona, less common in the southern 
part of the state. In the late summer, it feeds on 
branches of ash (Fraxinus velutinus) trees that 
are approximately one inch in diameter. The 
beetles peel away the bark by “plowing” into 
it with the clypeus, leaving long rectangular 
wounds.
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In Past Years - XV 1974-1975 Sabbatical
by Henry F. Howden

henry.howden@rogers.com

From September 1974 to 
September of the following year 
we had our first sabbatical year. I 
had some support, both from our 
National Research Council and the 
Australian CSIRO (Commonwealth 
Scientific and Industrial Research 
Organization), to work on 
the Australian bolboceratines 
(geotrupines). There was a lot of 
planning and we wanted to find 
someone to stay in our house while 

we were away. Our “house sitter” 
turned out to be our friends Henry 
Townes and his wife; they were glad 
to have the chance to work on the 
Hymenoptera in the CNC and to 
collect in Canada. Our two eldest 
daughters were in the university 
and were due to join us in Canberra 
at the end of their school year 
in May. Our youngest daughter, 
Lucile, was able to take the second 
half of her high school year through 
correspondence courses, and went 
with us. We finally left Ottawa on 
December 10.

So, with our planning done, we 
went first to Hawaii with some 
tiresome stops along the way. For 
a capital, Ottawa was really in 
the backwoods at that time. We 
couldn’t fly anywhere without a 
plane change either in Montreal 
or Toronto. Going westward, it 
was Toronto and we sat for most 
of the morning there waiting for 
our flight to Los Angeles. Then 
another long delay to connect to 
our flight to Hawaii. We finally 
arrived in Honolulu 19 hours after 
leaving Ottawa. Needless to say we 
didn’t do much the next day except 
wander around near the beach and 
make a brief visit to the nearby zoo 
(zoos are one of our weaknesses). 
One cage that housed some great 
apes had a sign warning the public 
not to get too close because one of 
the apes had a habit of throwing 
things if bothered. One young man 
decided to ignore the warning and 

Photo 1: Canyon on Kauai; not easy collecting on ridges. 
Similar ridges with some native vegation occur on Oahu.
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threw something into the cage. He 
had it returned with interest - a 
hand full of fresh dung which was 
well aimed and hit him just below 
his chin. He left in a hurry! We 
visited the Bishop Museum, took 
a tour of the island, did some low-
land collecting (Photos 1 and 2) 
which yielded a few nitidulids and 
tried to catch up on our time zones. 
After three days, we left for Sydney, 
Australia, with a short stop in Fiji. 
During the stop I collected several 
species of scarabs near the airport - 
no worry about security there.

In Sydney, we were met by Geoff 
Holloway, a friend from the time 
of the 1972 Congress in Canberra. 
He, his wife, Jan and son, Andrew, 
kindly hosted us during our stay 
in Sydney, Geoff helped us find a 
good used car that was in our price 
range. We had run into the usual 
problem that we couldn’t take a 
“child” in a government car, even if 
she was in her next to last year of 
high school. So, instead of letting 
us have a government car, we were 
given a grant to buy one. With 
Geoff’s help we found a car to suit 
our budget, a 1967 Holden Premier 
with 66,697 miles registered on 
the odometer; we had it inspected 
by the New South Wales (NSW) 
auto club (NRMA), and after a 
few minor things were fixed and 
insurance obtained from the auto 
club, we were finally mobile. Cost of 
the car with repairs and inspection 
was about $1,400 Australian 
dollars. The most daunting part 
was following Geoff in our new car, 
driving on the left side of the road 
through Sydney’s morning rush 
hour, south to the small coastal 
town of Gerroa. There Geoff had 

arranged for us to stay at a beach 
house just outside of town at the 
north end of Seven Mile Beach, a 
long crescent-shaped beach (picture 
3) backed by a protected forest and 
no houses.

We settled in, did some shopping, 
and started to learn the Australian 
version of English, such as “spinach” 
= Swiss chard, “chook” = chicken, 
“boot” = trunk of car, and so on. 
The area was rather dry, but the 
collecting was not bad; three species 
of Onthophagus were taken in traps 
and other scarabs came to light. 
Anne still remembers the revolving 
clothes line that squeaked when the 

Photo 2: Native trees on Kauai, typical of undisturbed 
areas.
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wind blew, which was most of the 
time. The first day, near our house, 
I nearly stepped on a “black snake” 
which, I learned, belongs to the 
cobra family, along with about 70% 
of the Australian snakes - it is best 
to avoid all snakes unless you know 
the Australian species! Geoff was 
full of tall stories about snakes, 
spiders, etc., and had a gullible 
listener in our daughter, Lucy. After 
a day, Geoff went back to Sydney 
and left us to our own devises, 
which included collecting and 
exploring the nearby escarpment, 
with its wet forest.

We learned one thing: that all 
along the east side of the Great 
Dividing Range, where wet forest 
is found, there are “stinging trees” 
mingled in with the other species. 
Fortunately these stinging trees are 
not common and the leaves have 
obvious “hairs” that would cause 
anyone familiar with nettles to be 
careful. Unfortunately the trees 
can reach a size similar to many 
others in the forest, and when a 
leaf from a stinging tree is shed 
and falls on you, the result can be 
extremely painful and long lasting. 
The pain may subside after a day 
or so, but every time you get wet it 
returns and this recurrent pain may 
last for months. When we were in 
Australia, the chemical causing the 
reaction was still unknown.

We avoided most of the local 
“natural” hazards, but not bad 
weather. On Christmas Day 
typhoon Tracy essentially 
destroyed Darwin, and while 
Darwin was on the northern coast 
of Australia, the aftermath reached 
as far south as southern NSW a 

Photo 3: Seven Mile Beach south of Sydney, New Ssouth 
Wales.

Photo 4: Beach drift at Seven Mile Beach; not often are 
beetles so easy to collect in numbers!
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few days later. Strong winds and 
intermittent rain changed our usual 
type of collecting from beating and 
digging to beach combing. Onshore 
winds blew thousands of insects 
onto the beach and the tide line was 
thick with beetles (Photo 4), if one 
got there before the birds. For two 
days we did little else; we kept notes 
on how many of each species we 
found, whether they were dead or 
not and density per yard. For Seven 
Mile Beach we estimate that there 
must have been several million 
insects washed up on the one 
seven mile stretch. The dominant 
beetle by far, was Cyclocephala 
signaticollis Burm., an exotic species 
from Argentina. Later a short paper 
on our findings was published in 
Biotropica, 1977, 9: 53-57. The 
discouraging part was that during 
our stay there we did not collect a 
single bolboceratine, although we 
were introduced to the infamous 
bush flies (Photo 5) which arrived 
along with the wind. More on these 
later.

We left Gerroa on the 2nd of 
January 1975 and drove up the 
escarpment to Canberra. There we 
were hosted by Ev Britton and his 
wife. The first few days were spent 
at the CSIRO looking over their 
extensive collection and, with the 
help of Murray Upton, finding out 
what was needed for field work 
in Queensland. Murray arranged 
for us to have the use of one of the 
CSIRO caravans (= house trailer). 
It did seem odd that we could haul 
a government trailer when we had 
our daughter with us, but not use 
a government car. So it goes. For 
several days while the car was being 
fitted with a trailer hitch, electric 

connections, etc., we collected 
locally, getting numerous dung 
beetles and melolonthids, but no 
bolboceratines.

Anne also encountered one of the 
less advertised Australian pests: a 
“bull ant”, which stung her on the leg 
while she was pulling bark. During 
our time in Australia, we came to 
believe that bull ants, with their 
nasty sting, were the major hazard 
to collectors in southern parts of the 
continent. They would come after 
you for no reason that we could 
discern, so one always needed to be 

Photo 5: Anne showing how easily she attracts insects 
(bush flies).
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on the lookout for these miserable 
pests, plus a few others (Photo 6)

Once the trailer hitch was installed, 
we hooked up the caravan and 
took it up Black Mountain, a 
steep hill just behind the CSIRO 
buildings. It turned out that the 
caravan, with girders reinforcing 
the undercarriage and an extra 
large water tank added, as well as 
several other refinements for long 
stays in the outback, was too heavy 
for our car to pull! The result was a 
burned out clutch. So, no caravan 
and several extra days spent in 
Canberra before we headed north. 
The car, with a newly added roof 
rack, looked like one of those 
cartoons of an overloaded wagon. 
However, we did fit ourselves in 
and even managed to keep our 
collecting equipment handy. It was 
just as well, as shortly after we left, 
we saw eucalyptus with blooms that 
we could reach (Photo 7 ). After half 
an hour of “working” the blooms, 
we had collected several species 
of melolonthids, several cetonids 
and a Microvalgus, along with half 
a dozen species of buprestids and 
cerambycids. This first stop slowed 
down the entire trip, as every time 
we saw some bloom that we could 
reach, we stopped to investigate.

The second day we were passing 
through a fairly wet area when 
we stopped for lunch at a pull 
off. To my amazement I saw what 
looked like a geotrupine burrow 
in the middle of the packed gravel 
pull off. It was slow digging, since 
at first I had to use a hammer 
and screwdriver to get through 
the hardened surface; 10 inches 

Photo 6: Emu; if semi-tame they can be a real pest or 
worse. Males can be aggressive, but can usually be scared 
away by holding your hands above your head and yelling 
to show that you are taller and louder.

Photo 7: Eucalyptus flowers; don’t pass them by.
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of digging turned up my first 
Australian bolboceratine, an 
Elephastomus. Joy, but no other 
burrows in sight, so we went on. 
We didn’t make great time; not 
only was the occasional flowering 
tree slowing us down, the narrow, 
winding road did not encourage 
speeding. It took three days for us 
to reach Toowoomba, Queensland, 
on the escarpment to the west 
of Brisbane. Toowoomba was 
an interesting town with, at that 
time, some great entomologists, 
including Peter Allsopp, who 
worked (and still does), on 
scarabs. He took us to a small 
patch of rain forest (Photo 8) near 
Ravensbourne where we were 
introduced to land leeches. In that 
patch of rain forest we picked up 
several of the delightful animals 
(Photo 9). I then found a dead 
pig almost covered with fallen 
leaves. All around the leaves were 
moving: carrion beetle heaven! I 
was wrong, there were hundreds 
of leeches in the leaves. If there 
were any beetles, I did not stay to 
look for them. Later we learned 
that repellents such as “Off” would 
discourage most leeches.

The next day we collected in more 
open forest near Toowoomba 
and took several species of 
bolboceratines, Elephastomus and 
Australobolbus. The somewhat 
wetter weather definitely improved 
collecting. My dung-baited pit-fall 
traps were christened “Howden 
traps” by Peter or an associate, and 
this label lasted for a few years. 
Fortunately this label has now 
become extinct.

Photo 8: Peter Allsopp near wet forest containing some 
unwanted fauna.

Photo 9: The unwanted fauna - a leech with racing stripe 
(?) and more.
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It was necessary for us to move 
on, so we reluctantly left and 
moved northward to Yeppoon 
on the coast. There the motel we 
selected backed on to the local 
movie theater, although we didn’t 
realize it at the time, but found out 
the first night! The “theater” had 
canvas sides which were raised in 
the evenings to let the cool(?) air 
in and the sound out. Every night 
we learned more than we wanted 
to about Mutiny on the Bounty. 
Fortunately, most evenings we were 
out collecting, so we were subject 
mostly to only the ending. Four 
days were spent collecting locally. 
Carrion and dung traps yielded 
numerous Onthophagus, plus many 
other beetles, and collecting on 
the beach or just behind yielded 
several species of tiger beetles. No 
bolboceratines were found, much to 
my disgust.

As we drove north toward Cairns, 
the road did not improve and just 
before we reached Townsville, a 
pot hole destroyed our muffler. So 
an unexpected overnight stop was 
made and the next morning the 

expedition continued with a new 
muffler (and fewer $). Arriving at 
Cairns, we found a caravan park 
called “Cool Water”, the name, it 
seemed, coming from the fact that 
it rained most of the time we were 
there. Collecting locally was mostly 
at a place called “Lake Placid”, a 
privately owned area containing a 
fairly level patch of lowland rain 
forest (Photo 10). The owners said 
we were welcome to all the insects, 
spiders, scorpions or any other 
pests we might find.

They had an interesting dog of 
a very mixed breed. The dog 
had been hit by a car that had 
broken its leg. While recovering, 
the dog received much attention 
and petting. Fully recovered, the 
attention vanished, much to the 
dog’s dismay. So a solution was 
found, every time someone looked 
at the dog he developed a limp, at 
other times he was fine! Since we 
caught on quickly and didn’t pet 
him, we were ignored - no limp.

When we visited Lake Placid it 
usually poured. A rain coat was 
no good; it was so hot and humid 
that one got wet either from rain 
or sweat. So wallets were wrapped 
with plastic and we just got wet. 
Dung traps, if covered with a rain 
roof, did very well. The tree trunk 
tiger beetles (Dystipsidera sp.) 
were interesting to watch. They 
would sit facing downward on the 
trunks of eucalyptus trees, often 
with a drop of water covering the 
mouth parts. I never saw them 
feed but they certainly could fly, 
or run to the other side of the tree. 
Beating was a great way to get 

Photo 10: Forest near Lake Placid and Cool Waters 
Caravan Park, Cairns, Queensland.
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drenched, so the traps were the 
only really productive method of 
getting any number of beetles.

After several days of rain, we 
decided to become tourists and 
take a boat trip out to Green 
Island at the edge of the barrier 
reef. It was a good idea, but most 
of the other passengers on the 
boat got sea sick, which rather 
spoiled the trip for us. Once on the 
island, there was bright sunshine 
and one could see it raining back 
in Cairns (Photo 11). One lucanid 
found on the island was given to 
us, but otherwise we looked at fish 
from an underwater observatory 
and enjoyed the dry weather.

Photo 11: Green Island, Queensland.

A member of the 
characteristic spring 
fauna of low deserts 
of the southwestern 
United States and 
northwest Mexico, 
Gymnopyge are 
diurnal flower feeders. 
The genus presently 
consists of four 
species, difficult to 
separate because of 
weak interspecific 
differences, sexual 
dimorphism, and 
high intrapopulation 
variability in color, size, 
and pilosity. Pictured 
here is (apparently) G. 
hopliaformis Linell, 
1935, on a preferred 
adult host, Geraea 
canescens Torr. & Gray. 
The data are:  USA: 
California, Imperial 
County, Highway. 78, 
4 miles west of Gecko 
Road, April, 1992, 
Barney Streit.
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The Rarest Scarab You Ever Collected

by The Editors

Our third story fest is on! The 
rules listed in Scarabs #28 (June, 
2008) have been thrown out! Tell 
us about the rarest scarab beetle 
you ever collected, even if it is just 
a paragraph or two. The deadline is 
November 30, 2008.

All those who enter will receive this 
autographed, high-quality 8 X 10 of 
Sonja (pronounced “sawn-ya”) who 
is one of our proof readers. Don’t 
forget to enter...getting a signed 
print of Sonja is now way easier than 
you ever imagined!

Editors’ Note: This is no 
longer a contest, because 
everyone who sends us a 
story receives a portrait 
suitable for framing.

Note also that this is 
not necessarily about 
collecting a rare species. 
It can be about bagging 
that scarab that you 
always wanted (in other 
words, rare to you) or 
perhaps difficult to 
collect.


